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Instructions for using the CD.
1.	 Insert the DVD into your DVD-ROM drive.

2.	 The program should run automatically.  If not, or if you 
want to access some of the additional resources on the 
DVD:

3.	 View the contents of the DVD using either “My 
Computer” (Windows) or Finder (Mac).

4. Right-click on the 
TSDI DVD and choose 
“AutoPlay” to run the 
program on Windows, 
or choose “Open” to 
view the files.

5. Double-click TSDI.
exe to run the 
program on Windows, or TSDI_Mac to run the program on Mac.

Above: the main 
interface of the 
Theatrical Sound 

Design Interactive 
program.
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Introduction
It is the goal of this course to introduce you to the methods and tools a sound designer uses to 

pick up a play, analyze it, form a concept for the audio, create a score, and cue a show from beginning 
to end!

A sound designer must know how to take an image from his/her mind and communicate their idea in 
many different ways:

	 * Words that a director will understand and talk about

	 * Onto paper that a stage manager (and later board operator) will understand

	 * Using the editing bay to prepare master cues for playback during the show

	 * Configure the playback system to give you the desired results for that particular production.

If this is done successfully, your finished sound cue will recapture the goal that you had set for 
yourself by creating that early morning on the farm, afternoon picnic, evening by the campfire, or night 
on 42nd street. 

Assignment 1
Go through the DVD segment “What is Sound?” and answer:

What is sound actually? 	 	 	 	 	 	 	 	 	 	

		 	 	 	 	 	 	 	 	 	 	 	 	

As sound waves travel, they lose their strength (volume).  Does their frequency change as well?

		 	 	 	 	 Yes	 	 No

Frequency refers to:

A) How fast you can hear a sound after it’s created.	 B) The rate at which sound vibrates.

C) How often you can hear the sound.	 	 	 D) Volume of a sound.

The Inverse Square Law explains that as the distance a sound travels doubles, the intensity is 
reduced by:

		 	 A) 25%	 B) 33%	 C) 50%		 D) 75%

Slight delay in what you hear compared to the source of the sound is called reverberation, which 
we consider fullness.  Too much delay can make sound muffled.  Extreme delay is considered

		 	 	 	 	 	 	 	 	 	 	 	 	

		 	 	 	 	 	 	 	 	 	 	 	 	

The tonal quality of a sound which includes frequency and harmonics of a note is described as
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Assignment 2
Go through the DVD segment “Recorders” under “Equipment” and then do the following editing assignment.

On the DVD, use “Finder” or “My Computer” to open the DVD, go in to the “Resources” folder, then 
“Assignments” folder; use the 01_Bread.wav file to:

Edit from; “I am going to take a walk to the store to buy some bread. Want to come 
along with me?”
To: “I am going to buy some bread. Want to walk to the store with me?”
	 You may use any audio editor you like.  
Sony Sound Forge http://www.sonycreativesoftware.com/products/soundforgefamily.asp
Adobe Audition http://www.adobe.com/products/audition/
and Pro Tools http://www.digidesign.com/index.cfm?navid=349&langid=100&itemid=35976
are considered leaders in the field, and typically offer a 30 day trial of their software - with packages 
running from approximately $99 - $250.
	 You may also visit www.TheatricalDesign.com/workbook for links to downloads, reviews, and 
training videos.

	 Audacity http://audacity.sourceforge.net/ is a slightly clunky but very powerful free audio 
editor which is also available on the DVD in the “Resources” “Software” folder.  It is available for 
Windows, Linux and Mac operating systems, 
and a tutorial is on the DVD via the “Equipment” 
“Recorders” “Editing Software” menu.  An 
introductory manual is also in this workbook.  You 
might consider, if you don’t have the budget to buy 
a software package (like one listed above) getting 
started by using Audacity - then once you’re 
somewhat familiar with how computer-based audio 
editing works, trying one of the 30-day trials for 
more advanced lessons/assignments.
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A Free, Open Source, Cross-Platform Audio Editor
Version 1.2.4

This is the quick introduction for Audacity. It is meant to be a quick reference, not a complete manual. 
There is also a complete manual available online at: http://audacity.sourceforge.net/manual-1.2/

	 This reference manual is printed with permission and in collaboration with SourceForge.
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Control Toolbar

Editing Tools

	Selection tool - for selecting the range of audio you want to edit or listen to.

 	Envelope tool - for changing the volume over time.

	Draw tool - for modifying individual samples.

	Zoom tool - for zooming in and out.

	Timeshift tool - for sliding tracks left or right.

	Multi tool - lets you access all of these tools at once depending on the location of the mouse 
and the keys you are holding down.

Audio Control Buttons

	 Skip to Start - moves the cursor to time 0. If you press Play at this point, your project will 
play from the beginning.

	 Play - starts playing audio at the cursor position. If some audio is selected, only the selection is 
played.

	 Loop - if you hold down the Shift key, the Play button changes to a Loop button, which lets you 
keep playing the selection over and over again.

	 Record - starts recording audio at the project sample rate (the sample rate in the lower-left 
corner of the window). The new track will begin at the current cursor position, so click the “Skip 
to Start” button first if you want the track to begin at time 0.

	 Pause - temporarily stops playback or recording until you press pause again.

	 Stop - stops recording or playing. You must do this before applying effects, saving or export-
ing.

	 Skip to End - moves the cursor to the end of the last track.

Toolbars
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Mixer Toolbar

The Mixer Toolbar has three controls, used to set the volume levels of your audio device and choose 
the input source. The leftmost slider controls the playback volume, the other slider controls the re-
cording volume, and the control on the right lets you choose the input source (such as “Microphone”, 
“Line In”, “Audio CD”, etc.). Use the Record Level Meter to set the correct level.
Changing these controls has no effect on the audio data in your project - in other words it doesn’t 
matter what the output volume level is when you Export or Save a project - the end result is the 
same.

Edit Toolbar

All of the buttons on this toolbar perform actions - and with a couple of exceptions, they’re all just 
shortcuts of existing menu items to save you time.
Holding the mouse over a tool will show a “tooltip” in case you forget which one is which.

	Cut

 	Copy

	Paste

	Trim away the audio outside the selection

	Silence the selected audio

	Undo

 	Redo (repeat last command).

	Zoom In

	Zoom Out
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 	Fit selection in window - zooms until the selection just fits inside the window.

	Fit project in window - zooms until all of the audio just fits inside the window.

Meter Toolbar

The Meter Toolbar is used for monitoring the input and output audio levels. Typically it is used to make 
sure that the loudest volume is as loud as possible (for maximum fidelity) without clipping or distorting 
it. The output (playback) meter is the green one, on the left in the picture above, and the input (re-
cording) meter is in red, on the right.

The meters provide a visual indication of the current audio levels going in and out of audacity.

If you float the Meter Toolbar, either by dragging it out of the toolbar or by selecting “Float Meter 
Toolbar” from the View menu, you can resize it and even orient it vertically.

Normally the meters are only active when you are playing or recording audio. However, you can also 
monitor input when you’re not recording - to do this, either select “Monitor Input” from the input 
meter’s pop-up menu, or else just click on the input meter. If you have a microphone or other input 
source attached, you will be able to watch the level of the audio before you start recording.

Each meter shows several characteristics of the audio level at once:

    * The right hand end of the meter corresponds to the point at which the audio will be clipped, and 
the left hand end is silence

    * For stereo, the top bar shows the left channel, and the bottom bar shows the right channel.
    * The brightest part of the bar shows the average audio level (related to the loudness) and the 

darker part of the bar shows the peak audio level.
    * The peak-hold line to the right of this shows the maximum audio level achieved in the last 3 sec-

onds.
    * Finally, the clipping indicators on the far right of each meter will light up if clipping is detected 

(meaning that the audio was too loud and will sound distorted).

If clipping is detected when you are recording, you should stop, lower the volume of your input 
source, and start recording again from the start. If the output meter clips then you need to make 
some or all of your tracks quieter using the track gain control.
If the level of the input (recording) source is too high, you can try to lower the input level using the 
Mixer Toolbar, but if this doesn’t work, you should try to lower the volume of the external input 
source (e.g., your microphone, cassette player, or record player).

It is possible, especially if you have an older, slower computer, that the Meter Toolbar may interfere 
with Audacity’s ability to record or play audio with the highest quality, because your computer is so 
busy redrawing the meters that it doesn’t have time to process enough audio. In this is the case for 
you, you can disable the Meter Toolbar in the Interface tab of the Preferences dialog.
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Menu Bar

Track Pop-Down Menu

The Track Pop-Down Menu appears 
when you click in a track’s title. This lets 
you access a few special commands 
that apply to individual tracks.

Name... - lets you change the name of 
the track.

Move Track Up - exchange places with the track above this one.

Move Track Down - exchange places with the track below this one.

Waveform - sets the display to Waveform - this is the default way of visualizing audio.

Waveform (dB) - similar to Waveform, but on a logarithmic scale, measured in decibels (dB).

Spectrum - display the track as a spectrogram, showing the amount of energy in different frequency 
bands.

Pitch (EAC) - highlights the contour of the fundamental frequency (musical pitch) of the audio, using 
the Enhanced Autocorrelation (EAC) algorithm.

Mono - makes this track a mono track, meaning it is played out of just one speaker, or played out of 
the left and right speakers equally.

Left Channel - makes this track come out of only the left speaker.

Right Channel - makes this track come out of only the right speaker.

Make Stereo Track - if there is another track below this one, joins them to make a single stereo 
track, with the top track representing the left speaker, and the bottom track representing the right 
speaker. When tracks are joined into a stereo pair, all edits automatically apply to both the left and 
right channel.

Split Stereo Track - if the selected track is a stereo track (a pair of left and right tracks joined to-
gether as a single track), this operation splits them into two separate tracks that you can modify and 
edit independently.

Set Sample Format - this determines the quality of the audio data and the amount of space it takes 
up. 16-bit is the quality used by audio CD’s and is the minimum quality that Audacity uses internally 
(8-bit audio files are automatically converted when you open them). 24-bit is used in higher-end 
audio hardware. 32-bit float is the highest quality that Audacity supports, and it is recommended that 
you use 32-bit float unless you have a slow computer or are running out of disk space.

Set Rate - sets the number of samples per second of the track. 44100 Hz is used by audio CDs. 
Tracks can have different sample rates in Audacity; they are automatically resampled to the project 
sample rate (in the lower-left corner of the window).
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File Menu
New - creates a new empty window
Open... - opens an audio file or an Audacity project in a new window (unless the current window is 

empty). To add audio files to an existing project window, use one of the Import commands in the 
Project menu.

Close - closes the current window, asking you if you want to save changes. On Windows and Unix, 
closing the last window will quit Audacity, unless you modify this behavior in the Interface Prefer-
ences.

Save Project - saves everything in the window into an Audacity-specific format so that you can save 
and quickly continue your work later. An Audacity project consists of a project file, ending in “.aup”, 
and a project data folder, ending in “_data”. For example, if you name your project “Composition”, 
then Audacity will create a file called “Composition.aup” and a folder called Composition_data. Audac-
ity project files are not meant to be shared with other programs - use one of the Export com-
mands (below) when you are finished editing a file.

Save Project As... - same as Save Project (above), but lets you save a project as a new name.
Recent Files ... - brings up a list of files you have recently opened in audacity to be re-opened quickly.
Export As WAV... - exports all of the audio in your project as a WAV file, an industry-standard format 

for uncompressed audio. You can change the standard file format used for exporting from Audacity 
by opening the File Format Preferences . Note that exporting will automatically mix and resample if 
you have more than one track, or varying sample rates. See also File Formats.

Export Selection As WAV... - same as above, but only exports the current selection.
Export as MP3... - exports all of the audio as an MP3 file. MP3 files are compressed and therefore 

take up much less disk space, but they lose some audio quality. Another compressed alternative 
is Ogg Vorbis (below). You can set the quality of MP3 compression in the File Format Preferences. 
See alsoMP3 Exporting.

Export Selection As MP3... - same as above, but only exports the current selection.
Export as Ogg Vorbis... - exports all of the audio as an Ogg Vorbis file. Ogg Vorbis files are com-

pressed and therefore take up much less disk space, but they lose some audio quality. Ogg Vorbis 
files tend to take up a little less disk space than MP3 for similar compression quality, and Ogg Vorbis 
is free from patents and licensing restrictions, but Ogg Vorbis files are not as widespread. You can 
set the quality of Ogg compression in the File Format Preferences.

Export Selection As Ogg Vorbis... - same as above, but only exports the current selection.
Export Labels... - if you have a Label Track in your project, this lets you export the labels as a text file. 

You can import labels in the same text format using the “Import Labels...” command in the Project 
Menu.

Export Multiple... - lets you split your project into multiple files all in one step. You can either split 
them vertically (one new file per track), or horizontally (using labels in a Label Track to indicate the 
breaks between exported files.

Page Setup - configure how Audacity will print out the track waveforms using the Print option, and 
what printer to use.

Print - Print out the main window view from audacity showing the tracks and waveforms.
Exit (Quit) - closes all windows and exits Audacity, prompting you to save any unsaved changes first.
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Edit Menu
Undo - This will undo the last editing operation you performed to your project. Audacity supports 

full unlimited undo - meaning you can undo every editing operation back to when you opened the 
window.

Redo - This will redo any editing operations that were just undone. After you perform a new editing 
operation, you can no longer redo the operations that were undone.

Cut - Removes the selected audio data and places it on the clipboard. Only one “thing” can be on the 
clipboard at a time, but it may contain multiple tracks.

Copy - Copies the selected audio data to the clipboard without removing it from the project.

Paste - Inserts whatever is on the clipboard at the position of the selection or cursor in the project, 
replacing whatever audio data is currently selected, if any.

Trim - Removes everything to the left and right of the selection.

Delete - Removes the audio data that is currently selected without copying it to the clipboard.

Silence - Erases the audio data currently selected, replacing it with silence instead of removing it.

Split - Moves the selected region into its own track or tracks, re-
placing the affected portion of the original track with silence. See 
the figure right: 

Duplicate - Makes a copy of all or part of a track or set of tracks 
into new tracks. See the figure right:

Select ... > All - Selects all of the audio in all of the tracks in the project.

Select ... > Start to Cursor - Selects from the beginning of the selected tracks to the cursor posi-
tion.

Select ... > Cursor to End - Selects from the cursor position to the end of the selected tracks.

Find Zero Crossings - Modifies the selection slightly so that both the left and right edge of the 
selection appear on a positive-slope zero crossing. This makes it easier to cut and paste audio 
without resulting in an audible clicking sound.

Selection Save - Remembers the current selection (or cursor position), allowing you to restore it 
later.

Selection Restore - Restores the cursor position to the last position saved by “Selection Save”.

Move Cursor ... > to Track Start - Moves the cursor to the start of the current track.

Move Cursor ... > to Track End - Move the cursor to the end of the currently selected track.

Move Cursor ... > to Selection Start - Moves the cursor to the start of the current selection.

Move Cursor ... > to Selection End - Moves the cursor to the end of the current selection.

Snap-To ... > Snap On - Enable Snap-To mode. When Snap-To mode is enabled, the selection will 
be constrained to the nearest interval on the time scale, by default the nearest second. So if you 
click and drag from 4.2 seconds to 9.8 seconds, it will result in a selection from 4 seconds to 10 
seconds, exactly. You can change the units that are snapped to using the “Set Selection Format” 
option in the View Menu .
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Snap-To ... > Snap Off - Turns Snap-To mode off letting you select arbitrary ranges of time

Preferences... - opens the Preferences dialog.

View Menu
Zoom In - Zooms in on the horizontal axis of the audio, displaying more detail about less time. You 

can also use the zoom tool to zoom in on a particular part of the window.

Zoom Normal - Zooms to the default view, which displays about one inch per second.

Zoom Out - Zooms out, displaying less detail about more time.

Fit in Window - Zooms out until the entire project just fits in the window.

Fit Vertically - Resizes all of the tracks vertically so they all fit inside of the window (if possible).

Zoom to Selection - Zooms in or out so that the selection fills the window.

Set Selection Format - lets you choose the formatting that is displayed at the bottom of the win-
dow indicating the current selection time. Options include film, video, and audio CD frames, seconds 
+ samples, or pure time. If you turn on Snap-To mode in the Edit Menu, the selection will snap to 
the frames or other quantization you have selected in this menu.

History... - Brings up the history window. It shows all the actions you have performed during the cur-
rent session, including importing. The right-hand column shows the amount of hard disk space your 
operations used. You can jump back and forth between editing steps quite easily by simply click-
ing on the entries in the window, the same as selecting Undo or Redo many times in a row. You 
can also discard Undo history to save disk space. The history window can be kept open while you 
work.

Float Control Toolbar - moves the Control Toolbar out of the window and into its own floating win-
dow, so you can position it wherever you want. The menu item changes to Dock Control Toolbar, 
which you can use to put the toolbar back into the main window.

Float Edit Toolbar - moves the Edit Toolbar out of the window and into its own floating window, so 
you can position it wherever you want. The menu item changes to Dock Edit Toolbar, which you can 
use to put the toolbar back into the main window.

Float Meter Toolbar - does the same thing for audacity’s VU meters which you use to set recording 
levels and adjust playback.

Float Mixer Toolbar - moves the Mixer Toolbar out of the window and into its own floating window as 
above.
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Project Menu
Import Audio... - This command is used to import audio from a standard audio format into your project. 

Use this command if you already have a couple of tracks and you want to add another track to the 
same project, maybe to mix them together. You cannot use this option to import Audacity Proj-
ects. The only way to combine two Audacity Projects is to open them in separate windows, then 
copy and paste the tracks.

Import Labels... - This command takes a text file which contains time codes and labels, and turns them 
into a Label Track.

Import MIDI... - This menu command imports MIDI files and puts them into a MIDI Track. Audacity can 
display MIDI files, but cannot play, edit, or save them yet.

Import Raw Data... - This menu command allows you to open a file in virtually any uncompressed for-
mat. When you select the file, Audacity will analyze it and try to guess its format. It will guess cor-
rectly about 90% of the time, so you can try just pressing “OK” and listening to the result. If it is 
not correct, however, you can use the options in the dialog to try some other possible encodings.

At the beginning of your imported track(s), you may notice a little bit of noise. This is probably the file’s 
header, which Audacity was not able to parse. Just zoom in and select the noise with the Selection 
Tool, and then choose Delete from the Edit Menu.

Edit ID3 Tags... - Opens a dialog allowing you to edit the ID3 tags associated with a project, for MP3 
exporting.

Quick Mix - This command mixes all of the selected tracks together. If you are mixing stereo tracks, 
or mixing tracks that are marked as Left or Right channel, the result will be a stereo track (two 
channels), otherwise the result will be mono.

Your tracks are implicitly mixed whenever you hit the Play button and whenever you export. This com-
mand offers a way to do it permanently and save the results to disk, saving on playback resources.

Note that if you try to mix two very loud tracks together, you may get clipping (it will sound like pops, 
clicks, and noise). To avoid this, drag the gain slider on the tracks down to reduce their volume be-
fore mixing.

New Audio Track - This creates a new empty Audio Track. This command is rarely needed,since im-
porting, recording, and mixing automatically create new tracks as needed. But you can use this to 
cut or copy data from an existing track and paste it into a blank track. If that track was at a non-de-
fault rate then you may need to use Set Rate from the Track Pop-Down menu to set the correct 
sample rate.

New Stereo Track - same as above, but creates a stereo track. You can also create a stereo track 
by joining two tracks using the track pop-down menu.

New Label Track - This creates a new Label Track, which can be very useful for textual annotation.

New Time Track - This creates a new Time Track, which is used to vary the speed of playback over 
time.

Remove Tracks - This command removes the selected track or tracks from the project. Even if only 
part of a track is selected, the entire track is removed. You can also delete a track by clicking the 
X in its upper-left corner. To cut out only part of the audio in a track, use Delete or Silence.

Align Tracks... - All the Align functions work on whole tracks or groups of tracks, not on selections, 
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even if they span across multiple tracks. They all operate by time-shifting tracks (moving them left 
or right), making it easier to synchronize tracks or get rid of silence at the beginning. The cursor or 
selection stays in the same place unless you use “Align and move cursor...”, below:

Align and move cursor... - same as the functions above, except that the cursor or selection is moved 
along with the tracks. That allows you to shift the tracks without losing your relative place.

Add Label at Selection - This menu item lets you create a new label at the current selection. You can 
title the label by typing with the keyboard and then hitting “Enter” when you’re done.

Add Label at Playback Position - This menu item lets you create a new label at the current location 
where you are playing or recording. Do this if you want to mark a certain passage while you’re lis-
tening to it. You can title the label by typing with the keyboard and then hitting “Enter” or “Return” 
when you’re done. Only available whilst audacity is playing.

Generate Menu
If you choose an item from the Generate menu when there are no tracks in a project, a new 
track is created. Otherwise, the current track is used.
If a track is selected and the cursor is placed in a single place in the track audio is inserted at 
the cursor position. The default duration is 30 seconds.
The audio created will replace the any selection, otherwise it is inserted into the track, shifting 
up later parts of the track.

Silence - inserts silence

Tone... - you can create a Sine wave, Square wave, or Sawtooth wave.

White Noise - inserts random audio samples, which sounds like pure static.

Any items which appear after these three built-ins are VST, Ladspa, or Nyquist plug-ins. It is possible 
for a poorly written plug-in to crash Audacity, so always save your work before using a plug-in. 
Note that any effect that doesn’t take any audio as input will automatically be placed in the Gener-
ate menu.
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Effect Menu
The items in this menu only work when you have audio selected. Audacity does not have any 
real-time effects; you must select the audio, apply the effect, and then listen to the results.
Most effects have a Preview button. Clicking on this button plays up to three seconds of audio, 
allowing you to hear what it will sound like after the effect is applied. This is useful for fine-tuning 
the effect parameters.

Repeat Last Effect - selecting this command is a shortcut to applying the most recent effect 
with the same settings. This is a convenient way to quickly apply the same effect to many 
different parts of a file.

Amplify - changes the volume of the selected audio. If you click the “Allow clipping” checkbox, 
it will let you amplify so much that the audio ends up beyond the range of the waveform, and 
is clipped (distorted). The default value when you open the effect is to amplifiy so that the 
loudest part of the selection is as loud as possible without distortion.

Bass Boost - enhances the bass frequencies in the audio.
Change Pitch - changes the pitch/frequency of the selected audio without changing the tempo. 

When you open the dialog, the starting frequency is set to Audacity’s best guess as to the 
frequency of the selection. This works well for recordings of singing or musical instruments 
without background noise. You can specify the pitch change in one of four different ways: 
musical note, semitones, frequency, or percent change.

Change Speed - changes the speed of the audio by resampling. Making the speed higher will 
also increase the pitch, and vice versa. This will change the length of the selection.

Change Tempo - changes the tempo (speed) of the audio without changing the pitch. This will 
change the length of the selection.

Compressor - compresses the dynamic range of the selection so that the loud parts are 
softer while keeping the volume of the soft parts the same. You can optionally normalise 
the recording afterwards, resulting in the entire piece having higher perceived volume.

Echo - very simple effect that repeats the selection with a decay, sounding like a series of 
echos. This effect does not change the length of the selection, so you may want to add 
silence to the end of the track before applying it (using the Generate Menu).

Equalization - Boost or reduce arbitrary frequencies. You can select one of a number of differ-
ent curves designed to equalize the sound of some popular record manufacturers, or draw 
your own curve.

Fade In - fades the selection in linearly
Fade Out - fades the selection out linearly
FFT Filter - similar to Equalization, lets you enhance or reduce arbitrary frequencies. The curve 

here uses a linear scale for frequency.
Invert - Flips the waveform vertically, the same as a phase inversion in the analogue domain.
Noise Removal - This effect lets you clean up noise from a recording. First, select a small piece 

of audio that is silent except for the noise, select “Noise Removal”, and click on the “Get 
Noise Profile” button. Then select all of the audio you want filtered select “Noise Removal” 
again, and click the “Remove Noise” button. You can experiment with the slider to try to 
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remove more or less noise. It is normal for Noise Removal to result in some distortion. It 
works best when the audio signal is much louder than the noise.

Normalize - allows you to correct for DC offset (a vertical displacement of the track) and/or 
amplify such that the maximum amplitude is a fixed amount, -3 dB. It’s useful to normalize all 
of your tracks before mixing. If you have a lot of tracks, you may then need to use the track 
gain sliders to turn some down.

Nyquist Prompt - for advanced users only. Allows you to express arbitrary transormations using 
a powerful functional programming language. See the Nyquist section of the Audacity web-
site for more information.

Phaser - the name “Phaser” comes from “Phase Shifter”, because it works by combining 
phase-shifted signals with the original signal. The movement of the phase-shifted signals is 
controlled using a Low Frequency Oscillator (LFO).

Repeat - repeats the selection a certain number of times. This operation is quite fast and 
space-efficient, so it is practical to use it to create nearly-infinite loops.

Reverse - This effect reverses the selected audio temporally; after the effect the end of the 
audio will be heard first and the beginning last.

Wahwah - uses a moving bandpass filter to create its sound. A low frequency oscillator (LFO) 
is used to control the movement of the filter throughout the frequency spectrum. Adjusts 
the phase of the left and right channels when given a stereo selection, so that the effect 
seems to travel across the speakers.

Plugins 1 to 15 ... etc. These submenus contain any VST, Ladspa, or Nyquist plug-ins loaded by 
audacity. It is possible for a poorly written plug-in to crash Audacity, so always save your 
work before using a plug-in effect.

Analyze Menu
Plot Spectrum - To use this feature, first select a region of audio from a single track, then se-

lect “Plot Spectrum”. It opens up a window that displays the Power Spectrum of the audio 
over that region, calculated using the Fast Fourier Transform. The graph represents how much 
energy is in each frequency. As you move the mouse over the display, it shows you the 
nearest peak frequency. This window can also display other common functions that are calcu-
lated using the Fast Fourier Transform, including three versions of the Autocorrelation func-
tion. The Enhanced Autocorrelation function is very good at identifying the pitch of a note.
The Analyze menu is intended for effects and plug-in effects that do not modify the audio, but 
simply open a dialog with some descriptive information. Audacity also supports Analyze com-
mands that create annotations in a Label Track.

Help Menu
About Audacity - displays the version number and credits. If you compiled Audacity yourself, 

check here to verify which optional modules were successfully compiled in.
Contents ... - opens this reference guide in a searchable form.
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Tracks
Audio Track

Waveform display

This is the waveform display part of the track, although it is also possible to display a spectrogram 
instead of a waveform here.

This image shows a stereo track, which is a group of two tracks - the top one is for the left channel, 
and the bottom one is for the right channel. If you need to edit the two channels as separate tracks, 
you can split them using the Track Pop-Down Menu.

Controls
The track Control Panel appears directly to the left of every track. Clicking in the 

panel outside of one of its buttons or controls selects the entire track. Shift-clicking 
a track label adds or removes that track from the selection. Also, clicking and dragging 
a track label is one way to rearrange the order of tracks.

At the top-left of the label is the close box. Click here to delete the track (though 
you can Undo this operation).

To the right of the close box is the track’s title. Clicking on the title brings up the 
Track Pop-Down Menu, allowing you to rearrange tracks and change various track op-
tions:

The next line in the label tells you the channel of the track (left, right, mono, or stereo) and the 
sample rate (e.g. 44100 Hz is the audio CD rate). Beneath that is the quality - 32-bit float is high qual-
ity but takes up more disk space, and 16-bit is the same quality as an audio CD.
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The Mute button stops this track from playing. The Solo button plays only this track (or other solo 
tracks) and overrides the Mute button. Muting and soloing doesn’t affect mixing or exporting, just 
playback within Audacity.

The top slider is the gain control - it affects the relative volume of the track. By default it only lets 
you select multiples of 3 dB, but if you hold down shift you can choose any level. Be careful not to 
set it too high, or you can exceed the maximum volume of a track, which results in clipping.

The bottom slider is the pan control - it affects the balance between the left and right speakers.

Vertical Ruler
The Vertical Ruler is a guide to the levels you see in the waveforms. A level of 1.0 or -1.0 is 

the maximum supported by the audio file - anything beyond these levels will be clipped, which 
can sound like distortion.

When the mouse is over the vertical ruler, it changes to a magnifying glass. By clicking, you 
can zoom in vertically, and by shift-clicking (or right-clicking) you can zoom back out. You can 
zoom out as much as a factor of 2, which can be useful for editing envelopes.

When zooming vertically, Audacity will automatically “snap” to the normal range of -1...1 when 
you get close. If you are having trouble resetting the vertical ruler, shift-click a bunch of times 
until the range is -2...2, then click once to zoom back to -1...1.

If you change the display on the Track Pop-Down menu then the units of the vertical scale will 
change to reflect this.
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Label Track
Label Tracks can be used to annotate an audio file. They can be used for lyrics, markers, or notes, 

and they can even be used to save selections.

To create a Label Track, select New Label Track from the Project Menu. Alternatively, simply click 
or select where you would like to place a label, and choose Add Label at Selection from the Project 
Menu, and a Label Track will be created automatically if one doesn’t already exist.

To add a new label, click or select where you want the new label to appear, then select Add Label 
at Selection from the Project Menu, then type the name of the label, and finally press Enter or click 
outside of the label.

In addition, you can use the Add Label at Playback Position command from the Project Menu if you 
want to add a label at a certain place while you are listening. By default, this command has a shortcut 
of Control+M.

To edit the name of a label, click anywhere in it. Zoom in first if there are too many labels crowded 
together and you are unable to click on the one you want. When a label is selected for editing, it 
looks like the first label below:

When editing the name of a label, you are limited to using just the backspace key for editing. There 
is currently no way to move the insertion point to append a letter to the beginning of a label.

Once a label is selected, you can move to the next label by pressing Tab, and move to the previous 
label by pressing Shift-Tab.

To delete a label or multiple labels, select the area containing the label flags you wish to delete, and 
choose Silence from the Edit Menu. Alternatively you can delete an individual label by clicking on it and 
pressing Backspace until you have deleted all of the characters in the label, then pressing Enter.

To move labels, use the normal editing commands like Cut, Copy, Paste, Delete, and Silence.

You can save a selection in a label. When you create a new label, the left selection edge deter-
mines the position of the label’s flag. However, the right selection edge is also stored in the label, and 
when you click on it, the full original selection will be restored. If you wish to apply this selection to 
only a subset of the tracks, shift-click in the label area to the left of each track’s waveform to change 
whether each track is part of the selection or not.

Exporting and Importing label tracks
Label Tracks are saved when you save an Audacity Project, so if you just want to continue using 

the labels along with the same file, just save a project. But you can also export the labels to a simple 
text file, and import them. This allows you to save information about the locations of events in an au-
dio file for use in another program, and also provides a way to mass-edit the labels if necessary.

To export a Label Track, choose Export Labels... from the File Menu. The exported file will contain 
one line per label, starting with the time offset in seconds, then a tab, and then the name of the label, 
for example:

To import a Label Track, choose Import Labels... from the File Menu.

1.217995    Bass intro
3.921073    Guitar enters
7.584454    Drums enter
11.070002   Chorus
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Time Track
The Time Track is a new feature that lets you change the rate of playback over time. Start by choos-

ing New Time Track from the Project Menu. Then change the range of time warping by clicking on the 
Track Pop-Down Menu and choosing Set Range (an option which only appears for Time Tracks). Older 
computers may be incapable of playing audio in real-time that makes use of a Time Track, however you 
can always Export the file as a WAV and then playback the WAV file later.

To edit the time warping, choose the envelope tool from the Control Toolbar - the same tool you 
use to edit amplitude envelopes in Audio Tracks. Click to create and edit control points. Drag points 
off-screen to delete them.

The Time Track has a ruler. As you edit the warping, the ruler will warp to show you at what time 
playback will reach each place in the audio.

MIDI Track (incomplete)
Audacity currently supports displaying MIDI files if you import them using Import MIDI in the Project 

menu.
Audacity does not support playing, recording, or editing MIDI files. It does not even support saving 

MIDI Tracks in a project file.
The current functionality is useful to only a small group of people who are studying algorithms that 

relate MIDI data to audio data and simply wish to see the visual representation of the MIDI data and 
how it lines up with the audio data.
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Preferences
Audio I/O

* Playback Device - Use this control to select the device that will be used for playback / audio out-
put. This is usually only applicable if your computer has more than one sound card.

* Recording Device - Select the devce that will be used for recording / audio input. Note that many 
devices have multiple sources such as Microphone and Line in - to select the input source you will 
need to use the Mixer Toolbar.

For finer control over audio I/O, open your system’s Sound control panel or the control panel soft-
ware that came with your sound card.

* Recording Channels - Use this to select the number of channels to record simultaneously. Select 
1 for mono and 2 for stereo. Audacity will support recording more simultaneous channels, but note 
that most sound cards only support stereo, and even if your sound card supports more than 2 in-
puts, you need a fast computer and a large, fast hard disk to record many channels for a long time.

Mono recording is not the same on all computers or sound cards. Sometimes recording mono only 
records the left channel, and sometimes it mixes the left and right channels.

* Play other tracks while recording new one - When this box is checked, Audacity will play existing 
tracks when you press record - otherwise it simply records the new track without letting you 
hear what you’ve already recorded. You can use this option to record harmonies with yourself or 
add a voiceover.

You may notice that when you play the two tracks you recorded together, they aren’t synchro-
nized. This is unavoidable to a certain extent, although Audacity tries to minimize it. To fix it, you will 
need to grab the Time Shift tool and slide one of the tracks around until it sounds right.

* Hardware Playthrough (Mac Only) - plays the audio you are recording straight back out to your 
headphones or speakers so you can hear it. This option is done in harware, so it is fast and 
doesn’t consume resources. However, it is only possibly if input and output are on the same 
sound device.

PC users can do the same thing in their volume control settings, turning up the relevant audio input.

* Software Playthrough - Does the same thing as hardware playthrough, but in software. This means 
that the audio you hear may be slightly delayed relative to the input, and activating this option will 
use some more system resources. However, it works on all systems, even if you are recording 
from one device and playing back through another.
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Quality
* Default Sample Rate - This controls the sample rate of new projects. To change the sample rate 

of an existing project, use the control in the lower-left corner of the main project window.

* Default Sample Format - This controls the default format used to store audio samples. 16-bit 
takes up the least space and is equivalent to audio CD quality. 32-bit float takes up twice as much 
space but is much more flexible.

If you have a fast computer and enough disk space, you should always use 32-bit float samples 
while editing, and then export your final mix as a 16-bit WAV file (the default).

* Real-time sample rate converter - Audacity has more than one sample rate converter that’s used 
when you have a track that’s not the same sample rate as the project. This option lets you set 
the converter used during real-time playback, which can be different than the one you use during 
Export or mixing.

* High-quality sample rate converter - Audacity has more than one sample rate converter that’s 
used when you have a track that’s not the same sample rate as the project. This option lets you 
set the converter used during Export and mixing, which can be different than the one you use for 
real-time playback.

* Real-time dither - Dithering is used when converting high-quality samples with a lot of dynamic 
range, to CD-quality samples, with less dynamic range. A small amount of dithering can make the 
audio sound a little bit better, but it can also slow down processing a little bit. This option lets you 
set the dithering used for real-time playback.

* High-quality dither - Dithering is used when converting high-quality samples with a lot of dynamic 
range, to CD-quality samples, with less dynamic range. A small amount of dithering can make the 
audio sound a little bit better, but it can also slow down processing a little bit. This option lets you 
set the dithering used during Export and mixing.
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File Formats
* When importing uncompressed audio files into Audacity

o Make a copy of the file before editing (safer) - Selecting this means that Audacity will take lon-
ger to import files, but it will always have its own copy of any audio you are using in a project. 
You can move, change, or throw away your files immediately after you open or import them 
into Audacity.

o Read directly from the original file (faster) - Selecting this means that Audacity depends on 
your original audio files being there, and only stores changes you make to these files. If you 
move, change, or throw away one of the files you imported into Audacity, your project may 
become unusable. However, because Audacity doesn’t need to make copies of everything 
first, it can import files in much less time.

* Uncompressed Export Format - This lets you select the format that Audacity will use when you 
export uncompressed files. 11 common options are displayed in the list, but you can also select 
“Other” and choose a nonstandard file format for Audacity to export.

* Ogg Export Setup - Use this control to set the quality of Ogg Vorbis exporting. Ogg Vorbis is a 
compressed audio format similar to MP3, but free of patents and licensing fees. A normal quality 
Ogg Vorbis file is encoded with a quality setting of “5”. Note that unlike MP3 encoding, Ogg Vorbis 
does not let you set a bitrate, because some audio clips are easier to compress than others. 
Increasing the quality will always increase the file size, however.

* MP3 Export Setup - Use these controls to locate your MP3 encoder and set the quality of MP3 
encoding. Higher quality files take up more space, so you will need to find the level of quality you 
feel is the best compromise. For more information, see Exporting MP3 Files.

Spectrograms
You can view any audio track as a Spectrogram instead of a Waveform by selecting one of the 

Spectral views from the Track Pop-Down Menu. This dialog lets you adjust some of the settings for 
these spectrograms.

* FFT Size - The size of the Fast Fourier Transform (FFT) affects how much vertical (frequency) detail 
you see. Larger FFT sizes give you more bass resolution and less temporal (timing) resolution, and 
they are slower.

* Grayscale - Select this for gray spectrograms instead of colored ones.

* Maximum Frequency - Set this value anywhere from a couple of hundred hertz to half the sample 
rate (i.e. 22050 Hz if the sample rate is 44100 Hz). For some applications, such as speech rec-
ognition or pitch extraction, very high frequencies are not important (visually), so this allows you to 
hide these and only focus on the ones you care about.

Directories
Use this panel to set the location of Audacity’s temporary directory (folder). Audacity uses this 

directory whenever you work on a project that you haven’t saved as an Audacity Project (AUP file) 
yet. You have to restart Audacity (close and open it again) for changes to the temporary directory to 
take effect.
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Interface
* Autoscroll while playing - Scrolls the window for you while playing, so that the playback cursor is 

always in the window. This can hurt playback performance on slower computers.

* Always allow pausing - Normally the Pause button is only enabled while you are playing or record-
ing. Checking this box allows you to set the pause button anytime, which allows you to press Re-
cord and not have the recording start until you unpause it. Sometimes starting a paused recording 
can be faster than starting to record in the first place.

* Update spectrogram while playing - Because spectrograms are slower to draw, normally they are 
not drawn during playback, but this option lets you draw the spectrograms anyway.

* Enable Edit Toolbar - Sets whether or not you want to display the Edit Toolbar, which has some 
common shortcuts for editing commands.

* Enable Mixer Toolbar - Sets whether or not you want to display the Mixer Toolbar, which lets you 
set the volume levels and input source.

* Enable Meter Toolbar - Sets whether or not you want to display the Meter Toolbar for setting 
audio recording and playback levels.

* Quit Audacity upon closing last window - By default on Windows and X-Windows (but not Mac 
OS), Audacity quits when you close the last project window. If you uncheck this box, Audacity will 
open a new blank document instead of quitting. To quit Audacity in this case, you must specifically 
select Exit (or Quit) from the File menu.

* Enable dragging of left and right selection edges - Normally, when you move the mouse over the 
left and right edge of a selection, the cursor changes to a left or right pointer, and you can ad-
just that edge of the selection independently. If you don’t like this feature, uncheck this box, and 
then clicking will always create a new selection (unless you hold down Shift to extend an existing 
selection).

* Language - sets the language used by Audacity. Language files are named “audacity.mo” and are 
found in the “Languages” folder on Windows and Mac OS X, or in /usr/share/locale or /usr/local/
share/locale on most Unix systems. Audacity will detect new languages the next time you start it.

Keyboard
This panel lets you change keyboard shortcuts. All of the commands that appear in Audacity menus 

appear on the left, along with a few other buttons that can get keyboard shortcuts. To change a 
command, first click on the command you want to change. Then type the new keyboard shortcut on 
your keyboard. Verify that the correct shortcut appears in the box below. If it’s what you want, press 
the Set button. Or to get rid of a keyboard shortcut, press Clear.

To reset to Audacity’s defaults, press the Defaults button. This will get rid of any changes you have 
made.

If you have customized your keyboard layout and want to share it with someone else, you can 
press Save... and save your complete keyboard layout as an XML file that you can share. To load an 
existing layout, press the Load... button and locate the XML file.

Mouse
This panel doesn’t let you change anything, but it lets you view all of the commands and actions that 

you can do using the mouse, many by holding down extra modifier keys.
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Sound File Formats
Audacity Project format (AUP)

Audacity projects are stored in an AUP file, which is a format that has been highly optimized for 
Audacity so that it can open and save projects quickly. In order to achieve this speed, Audacity 
breaks larger audio files into several smaller pieces and stores these pieces in a directory with a 
similar name as the project. For example, if you name a project “chanson”, then Audacity will create 
a project file called chanson.aup to store the general information about your project, and it will store 
your audio in several files inside a directory called chanson_data. While the Audacity Project format is 
based on XML and is meant to be open, it is not currently compatible with any other audio programs, 
so when you are finished working on a project and you want to be able to edit the audio in another 
program, select Export from the File Menu.

WAV (Windows Wave format)
This is the default uncompressed audio format on Windows, and is supported on almost all 

computer systems. Audacity can read and write this format. People working with multichannel audio at 
very high quality settings, or with very long recordings, should note that the maximum size of a wav 
file is 2GB.

AIFF (Audio Interchange File Format)

This is the default uncompressed audio format on the Macintosh, and it is supported by most 
computer systems, but it is not quite as common as the WAV format. Audacity can read and write this 
format.

Sun Au / NeXT
This is the default audio format on Sun and NeXT computers, and usually u-law compressed, so it is 

not a very high quality format. U-law compression is a very simple, fast but low quality way to reduce 
the size of the audio by about 50%. This format was one of the first audio formats supported by 
Web browsers, and it is still often used for short sound effects where quality is not as important.

Audacity exports both 8-bit u-law files, and 16-bit uncompressed files, which are the same quality 
as wav or aiff files.

MP3 (MPEG I, Layer 3)
This is a compressed audio format that is a very popular way to store music. It can compress audio 

by a factor of 10:1 with very little degradation in quality. Audacity can both import and export this 
format. For more information on how to export MP3 files from within Audacity, see Exporting MP3 
Files.

Ogg Vorbis
This compressed audio format was designed to be a free alternative to MP3. Ogg Vorbis files are 

not as common, but they are about the same size as MP3 with better quality to rival AAC or WMA. 
Audacity can import and export this format.
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Envelope Editing
Audacity lets you edit the amplitude envelope of a track directly using the Envelope Tool:

	Envelope tool

Editing the amplitude envelope lets you change the volume of a track gradually over time by adding 
a number of control points to the track. Each control point sets the amplitude (volume) at that point 
in time, which can be as low as zero, and as high as 150% of the normal maximum volume, and the 
volume is interpolated smoothly between the points.

The image below shows a track with an amplitude envelope, with the Envelope Tool selected: Track 
With Volume Envelope

In the figure above, there are five control points, at 1.0, 3.0, 5.0, 7.0, and 9.0 seconds. Each control 
point has up to four “handles” arranged vertically. The top and bottom handles are positioned at the 
target volume, and the middle handles are positioned a quarter-screen down, giving you a way to 
move the envelope above the 1.0 level.

Note the dotted line at the top and bottom between 5.0 and 8.0 seconds. This indicates that the 
actual envelope is above the screen. You can see the entire contour by zooming vertically - position 
the cursor over the vertical ruler to the left of the track and shift-click to zoom out.

To create a new control point, just click. To move a point, just drag. To remove a point, click on it 
and drag it outside of the track, then let go.

MP3 Exporting
Audacity cannot encode MP3 files by itself, because the MP3 encoding algorithm is patented and 
cannot legally be used in free programs. However, Audacity has been programmed to recognize other 
existing MP3 encoders that you can download separately. All you have to do is obtain the appropriate 
MP3 encoder for your computer and then show Audacity where it is located.
If you use... 	 You need to...
Windows 	 Download LAME and look for the file called lame_enc.dll
Linux/Unix 	 Download LAME and compile it as a shared object, then look for the file called libm-

p3lame.so
Macintosh 	 Download LAMELib (see our website for more info).

For links to these MP3 encoders, go to the Audacity web page (http://audacity.sourceforge.net/) 
and go to the page for your operating system.

The first time you try to export an MP3 file, Audacity will ask you to locate your MP3 encoder. 
Locate the file indicated above. From then on, Audacity will not need to ask you again and you will be 
able to export MP3 files easily.
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General Public License
Note: Audacity is distributed under the terms of the GNU General Public License (GPL) - the full text of the license is below. All of the source code 

to Audacity is available from http://audacity.sourceforge.net. However, some of the libraries that Audacity is based on are distributed under the terms of 
different (but GPL-compatible) licenses.

Version 2, June 1991
Copyright (C) 1989, 1991 Free Software Foundation, Inc.
59 Temple Place - Suite 330, Boston, MA  02111-1307, USA
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.
Preamble
The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU General Public License is 

intended to guarantee your freedom to share and change free software--to make sure the software is free for all its users. This General Public License 
applies to most of the Free Software Foundation’s software and to any other program whose authors commit to using it. (Some other Free Software 
Foundation software is covered by the GNU Library General Public License instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you have the 
freedom to distribute copies of free software (and charge for this service if you wish), that you receive source code or can get it if you want it, that 
you can change the software or use pieces of it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to surrender the rights. These 
restrictions translate to certain responsibilities for you if you distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all the rights that you have. You 
must make sure that they, too, receive or can get the source code. And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal permission to copy, distribute 
and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no warranty for this free software. If 
the software is modified by someone else and passed on, we want its recipients to know that what they have is not the original, so that any problems 
introduced by others will not reflect on the original authors’ reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redistributors of a free program will 
individually obtain patent licenses, in effect making the program proprietary. To prevent this, we have made it clear that any patent must be licensed for 
everyone’s free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
0. This License applies to any program or other work which contains a notice placed by the copyright holder saying it may be distributed under the 

terms of this General Public License. The “Program”, below, refers to any such program or work, and a “work based on the Program” means either the 
Program or any derivative work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim or with modifications 
and/or translated into another language. (Hereinafter, translation is included without limitation in the term “modification”.) Each licensee is addressed as 
“you”.

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act of running the Program 
is not restricted, and the output from the Program is covered only if its contents constitute a work based on the Program (independent of having been 
made by running the Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium, provided that you conspicuously and 
appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to 
the absence of any warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange for a fee.
2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the Program, and copy and distribute such 

modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:
 * a) You must cause the modified files to carry prominent notices stating that you changed the files and the date of any change.
 * b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived from the Program or any part 

thereof, to be licensed as a whole at no charge to all third parties under the terms of this License.
 * c) If the modified program normally reads commands interactively when run, you must cause it, when started running for such interactive use 

in the most ordinary way, to print or display an announcement including an appropriate copyright notice and a notice that there is no war-
ranty (or else, saying that you provide a warranty) and that users may redistribute the program under these conditions, and telling the user 
how to view a copy of this License. (Exception: if the Program itself is interactive but does not normally print such an announcement, your 
work based on the Program is not required to print an announcement.)
These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the Program, and can be 

reasonably considered independent and separate works in themselves, then this License, and its terms, do not apply to those sections when you 
distribute them as separate works. But when you distribute the same sections as part of a whole which is a work based on the Program, the distribution 
of the whole must be on the terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part 
regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to exercise the 
right to control the distribution of derivative or collective works based on the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work based on the Program) on a volume of a 
storage or distribution medium does not bring the other work under the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form under the terms of Sections 
1 and 2 above provided that you also do one of the following:
 * a) Accompany it with the complete corresponding machine-readable source code, which must be distributed under the terms of Sections 1 

and 2 above on a medium customarily used for software interchange; or,
 * b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your cost of physically 

performing source distribution, a complete machine-readable copy of the corresponding source code, to be distributed under the terms of 
Sections 1 and 2 above on a medium customarily used for software interchange; or,
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 * c) Accompany it with the information you received as to the offer to distribute corresponding source code. (This alternative is allowed only 
for noncommercial distribution and only if you received the program in object code or executable form with such an offer, in accord with 
Subsection b above.)
The source code for a work means the preferred form of the work for making modifications to it. For an executable work, complete source code 

means all the source code for all modules it contains, plus any associated interface definition files, plus the scripts used to control compilation and 
installation of the executable. However, as a special exception, the source code distributed need not include anything that is normally distributed (in 
either source or binary form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs, unless that 
component itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then offering equivalent access to copy 
the source code from the same place counts as distribution of the source code, even though third parties are not compelled to copy the source along 
with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this License. Any attempt otherwise to 
copy, modify, sublicense or distribute the Program is void, and will automatically terminate your rights under this License. However, parties who have 
received copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to modify or distribute the 
Program or its derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by modifying or distributing the Program 
(or any work based on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or 
modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically receives a license from the original 
licensor to copy, distribute or modify the Program subject to these terms and conditions. You may not impose any further restrictions on the recipients’ 
exercise of the rights granted herein. You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues), conditions 
are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the 
conditions of this License. If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, 
then as a consequence you may not distribute the Program at all. For example, if a patent license would not permit royalty-free redistribution of the 
Program by all those who receive copies directly or indirectly through you, then the only way you could satisfy both it and this License would be to 
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is intended to apply and the 
section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of any such claims; this 
section has the sole purpose of protecting the integrity of the free software distribution system, which is implemented by public license practices. Many 
people have made generous contributions to the wide range of software distributed through that system in reliance on consistent application of that 
system; it is up to the author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot impose that 
choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.
8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted interfaces, the original copyright 

holder who places the Program under this License may add an explicit geographical distribution limitation excluding those countries, so that distribution is 
permitted only in or among countries not thus excluded. In such case, this License incorporates the limitation as if written in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from time to time. Such new versions will be 
similar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version number of this License which applies to it and “any later 
version”, you have the option of following the terms and conditions either of that version or of any later version published by the Free Software 
Foundation. If the Program does not specify a version number of this License, you may choose any version ever published by the Free Software 
Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are different, write to the author to 
ask for permission. For software which is copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimes make 
exceptions for this. Our decision will be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting 
the sharing and reuse of software generally.

NO WARRANTY
11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE 

LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM “AS IS” WITHOUT 
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE 
DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY 
WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA 
OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY 
OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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Assignment 3
American Pie Medley
* Combine the (3) versions of “American Pie” (in the Assignment 2 folder of each individual on 

the computer in my outer office) into one song.
* All 3 versions (Madonna, Weird Al, and the original Don McClean version) should be repre-

sented at least 3 times each in the final song which should run between 2:30 (2 minutes, 30 
seconds) and 5:30 (5 minutes and 30 seconds) in length. 

	 Sources may be purchased from:
http://astore.amazon.com/theatricaldesign-20?_encoding=UTF8&node=6

Assignment 4
Go through the DVD segment “How We Hear” and answer the following:

The “Middle Ear” consists of the three smallest bones in the human body.  Name these three bones: 

	 			   	 			   	 			 
Sound pressure enters the outer ear and is transferred into physical movement when it hits 

the tympanic membrane (which is commonly known as the 		   		  )

The semicircular canals use fluid / movement to transmit information about balance.  They are 
part of the ear, connected via the vestibule but do they affect hearing?	 Yes	 No

Assignment 5
This weeks’ assignment is a little different. First watch the DVD lecture “Script Analysis & 

Production Development”, then read the entire script of “Water Stealers” beginning on page 34 of 
this workbook and consider a concept for the project.

Assignment 6
Watch the DVD lecture “Cue Plot”.  Then, using the Parts of the Sound Design; Developing the 

Score excerpt (next two pages) as a guide - create a Sound Plot for “Water Stealers” 2 Scenes

“Orius Exterior” “Pool A” Pub section

These two scenes are on page 33 of this workbook.  You can also watch the scenes on the DVD 
in the “Resources” “Videos” folder...using “My Computer” or “Finder” to find the files.

Sample:

Cue 	Page	 When 	 	 What 	 	 Your notes

A 	 14	 Kyle goes to	 Toilet flushes	 After the flush begins, add the sound of water seeping

	 	 	 the bathroom 	 in background 	 over the sides, then VERY loud plunger noises!

Your assignment should be a “Word” document file, “Excel” Spreadsheet, “Access” database, or 
some other type of electronic file that you can add additional columns to at a later time. Be sure you 
keep a copy of the electronic file!

As with any production discussion, you should be ready to talk about the production as a whole 
- and your concept for it - in addition to “simply” doing the assignment.
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Parts of the Sound Design; Developing the Score Sound Design for Theatre
THE FUNCTION AND INTENT OF SOUNDS

In dealing with a particular cue, even one as simple as a car horn, you must ascertain many facts 
about that sound. Ask yourself why the sound is there in the first place. Is it to announce an arrival? 
To show impatience? To suggest traffic? How specific or arbitrary is the relationship between the 
sound and the dialogue? Is the sound associated with a character, and if so, does it need to reflect 
an aspect of the character? You need to know the period of the automobile, the distance that it is 
coming from, the time of day, the weather conditions, and the locale. To build a sound cue that will be 
supportive and appropriate to the play, you must glean information from the director, the script, and 
the production itself.

Beyond mere function, there is a psychological intent behind the use of a particular sound device. 
This intent derives from the playwright or director, and relates to the character affecting that device. 
An offstage car horn, blown by a character already introduced to the audience, may show that he is 
angry, impatient, or late for an appointment. If the horn is meant to summon someone, the result may 
be to annoy a particular character to the point of rage; in this case, the cue’s function is not to bring 
the character outside, but to trigger a reaction. The intent behind a cue, then, has bearing on how you 
choose to execute it.

There are times when your sound design must create an unseen character interacting with the 
characters onstage. In this case, you develop an offstage reality that is more completely realized than 
just the surface effect of a horn. This design choice not only supports, but also interacts with the 
onstage action. With the horn that enrages an onstage character, for instance, you could add (offstage 
or prerecorded) the extra annoyance of someone in the car yelling for the character to come out.

CONVENTIONS OF MUSIC AND EFFECTS
Music and effects used in a production fall into four categories: framing effects (preshow, 

entr’acte, and curtain call), underscoring, transitional sounds/ music, and specific cues.

Framing effects act as the bookends of a production. They exist outside the actual action of a 
play. They can comment on what will be or has been seen, but work independently from the actor’s 
presentation of the play. In musical terminology, the preshow is a “prelude,” the entr’acte (at 
intermission) a “bridge,” and the curtain call a “coda.”

Underscoring accompanies the action of a scene, and is not heard by the characters onstage. Its 
purpose is to underline the emotions of the moment. To maintain the focus of the scene, it may be 
helpful to place underscoring upstage of the actors. This forces the audience to listen “through” the 
actors, and keeps the sound literally in the background.

Transitional sounds or music represent a movement of the action through time or place. They exist 
outside the action, and can link one scene to the next. Placing transitional sound or music cues in 
speakers away from the stage helps support the idea that the cue exists outside the action of the 
play.

The characters in a play are, however, aware of specific cues. While not at all devoid of emotional 
appropriateness, specific cues are more informational in purpose than the other forms, and are aural 
events that form part of the theatrical environment. Location of these cues is dictated by the practical 
placement onstage of the sources from which they emanate.
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Specific Cues
Specific cues fall into five areas: required music, spot effects, ambiance, progression of effects, 

and voiceovers. All sound cues need to be emotionally correct, but specific cues are primarily 
informational in nature, supplying of-the-moment data and supporting play development. Omitting these 
cues would be conspicuous. When characters let the audience know that they hear a marching band, a 
barking dog, a car horn, or a ringing phone, those cues had better be there.

Required music is a particular piece of music that is indicated at a certain moment in the script.

Spot effects are specific sounds such as thunderclaps, dog barks, and explosions.

Ambiance is a wash of sound, the primary purpose being to provide an atmosphere, rather than to 
highlight a specific event as the spot effect does.

Occasionally, the script demands spot effects that seem to come out of nowhere. If you find 
mention of just one thunderclap in a script, it may be appropriate to set up distant rumbles ahead of 
it, to suggest a realistic progression of effects. The same holds true with the time after an effect 
— you may want to have a storm dissipate slowly.

Voiceovers appear within the action of the play, but are not perceived by the characters.

A sound cue is any introduction of an aural element into a production. Cuing refers to the 
manipulation of that element. That manipulation could be the entrance, volume change, segue, transition, 
or exit of that element. The subtleties that you incorporate into your cuing control the focus.

The Location and Movement of Sounds
The location and movement of a sound are as vital as all your other considerations. In a realistic 

design, a sound should come from its implied location. Onstage telephones should ring at the source. 
An outside environment heard from the setting of an interior should be placed so that it seems to 
emanate from open windows or doors.

Movement is used to provide greater realism and is often necessary to make an effect seem 
complete.

Not all of the sound or music that you are asked to provide will be prerecorded. Sometimes it’s 
necessary to use live effects (a crash box), musical instruments, or practical* (working effects like an 
onstage doorbell). Some cues will be a combination of live and prerecorded sounds.

From Sound and Music for the Theatre: The Art and Technique of Design, Second Edition 
(Paperback) by Deena Kaye (Author), James LeBrecht (Author) Publisher: Focal Press; 2 edition 
(September 1999) ISBN-10: 024080371X  ISBN-13: 978-0240803715
Available at: http://astore.amazon.com/theatricaldesign-20/detail/024080371X
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     	I strongly recommend reading the entire script (only 13 
pages) but this is what the required script segments look like:
Orius Exterior Commander Jones is working outside on a mechanical unit near a lake with trees behind him. 
JONES: Alpha station, the repairs to this oxygenation unit are nearly complete. Just in time, too – I’m. . . 

(listening to his headset – visibly agitated) Entered the system? Are you sure? We haven’t seen any 
indications of life. (listening) Are you certain the sensors are functioning properly? Weapons lock? Bring 
ground systems on line and begin transmitting the situation to EPOC command. Audio alarm begins in 
background

Orius Exterior. Different shot of Orius. Commander Jones is outside by a box near a water bank. We can see 
the missiles over a hill behind him. One streaks toward the sky. A warning alarm is sounding in the 
background. 

Zoom in / close up of Commander Jones as he looks up after the missile. He reacts to a mid-air explosion. 
JONES: What do you mean you can’t get a lock on this thing? Pull everyone inside, and see if the other 

probes have been engaged… 
Orius Exterior The water is pulled from the planet (CG). 
Orius Exteriror should look like the same location where Jones was working- no water, and the land is ravaged. 

Gold Mine zoom out. 

Kyle is in the Pub playing pool with some friends. Dale, Mike & Tracy. Extras OK. It’s midday, though, and 
they’re in a pub – so it shouldn’t be too busy. 

KYLE: OK Guys, watch and learn 
DALE: Nice Shot 
MIKE: Did you handle your balls that well last night? How’d it go with Julie? 
KYLE: I don’t know… I wasn’t the one handling the ‘stick’. 
TRACY: C’mon, quit being disgusting. Julie’s my friend. 
KYLE: We had a good time. That’s all. 
DALE: Can you still shoot straight after last night? 
MIKE: This man can never shoot straight. 
KYLE: Shut up guys 
<BEEPER> Kyle puts on his communicator. 
KYLE: Casually This is Sleigh, what’s the play? Realizing it’s official, he stands straighter. Oh, yes sir. 
GENERAL STRYKER is on the communicator. Shot from the perspective of looking through his communicator 

glass – Stryker is a pale blue projection over the pool hall background. Corporal Sleigh, we have a 
priority briefing for you in one half hour. Join us in the SitCom. (SITuation COMmand room) 

KYLE: Yes, sir. Right away….I understand. 
KYLE: Well, gotta go 
DALE: Just as you were about to start losing. 
KYLE: In your dreams, Dale-face. 
Kyle leaves via the door, gets on his pod, and races off. This will require a few location shots to get him 

racing off. 
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“Water Stealers” an interactive DVD by Kade Mendelowitz 

VOICE OVER: for opening and ending – perhaps done by JONES? 

JANICE: Young Scientist working in ALPHA central control room. Off white uniform. 

JONES: Commander of Orius. Part scientist, part military, part engineer. Good looking, confident leader. Off white uni-
form. 

BLAIR OTAHM: Earth Ambassador, formal, great presence. Excellent diction, though perhaps with an accent of some sort. 
Colorful (red?) shirt. 

COMPUTER VOICE: Excellent diction, though emotionless. Will have a digitized effect processed to it, so it may not be 
critical who does this. Maybe BLAIR? 

KYLE SLEIGH: Hot shot pilot. Good looking, a little too cocky. Reckless. Dad was in the air force, he’s following the 
path. 

MIKE, TRACY, DALE: Friends of Kyle, around 22 years old. Dale’s a trouble-maker. 

KATRINA BILLINGSWORTH: Truly the best pilot in the fleet, and a born leader. She’s had to work hard to become a 
Captain in the corp. to get where she is – and so young. She’s tough, but still very feminine. She can com-
partmentalize emotions very well. Crew call her Kat because she’s dangerous as well as sexy. She’s having a 
not-so-secret relationship with Stryker (she loves him and gets to see a sensitive side no one else ever sees), 
but they don’t get in trouble because they don’t flaunt it in front of others. 

JASMINE MINORAH: Lieutenant. She takes her responsibilities very seriously – career pilot, though she’s slightly recon-
sidering her life goals now that she’s a mother of a child under 2. 

DAVID MINORAH: Husband of Jasmine. He fell in love with a woman who was a frantic dancer in a bar one night who 
turned out to be a pilot that knows how to party hard. He loves his wife dearly, though he doesn’t understand 
her desire to be a pilot/protector. 

LUCINDA THORN: Lieutenant. She started out as an administrator and worked her way up to rank. She got turned on to 
being a pilot thinking it would be an exciting adrenaline rush – and it was. A year ago she was in an acciden-
tal dogfight (while on a routine patrol) with the head of a terrorist group, who happened to be Royalty of a 
small country. Her quick thinking, and a little luck, lead her to a victory – where she gained a reputation for 
excellence that she may not fully deserve. Very smart and beautiful. She’s having a secret affair with Riley. 

RILEY COHEN: Lieutenant. A dashing guy who’s a good pilot and use to be in “Demolition”. He believes he has bet-
ter leadership skills than he has – because he loses his temper easily. An energetic guy with a baudy humor. 
Secretly having an affair with Lucinda – he loves her, but hasn’t come to grips with that yet. 

JACK KINGLY: Corporal. He was class clown when he was younger, and was to be in “Special Operations” where he was 
trained to be lethal with any kind of weapon known. He is full of life – and enjoys and gets excited about 
everything he does. Unfortunately, he was stabbed in the left leg 2 years ago – which took him out of OPs, but 
his health is fine otherwise – and he’s an excellent pilot with great natural ability. A long time ago, he and Kat 
were….close. Quick thinker. 

GENERAL STRYKER: His father was a famous General, and he’s an even greater leader than his father. A child prodigy 
of sorts, he’s the youngest General in American Military history, and was in charge of the continuing develop-
ment of the Space Program for 2 years leading up to today. Very competent – and somewhat admired. He’s 
having a not-so-secret relationship with Kat, but they don’t get in trouble because they don’t flaunt it in front 
of others. He had a very romantic plan in place to propose marriage the coming weekend, but this situation 
put a kink in everyone’s life. 

MOORE: A military strategist. 

DAVIS: Astronomer, “ET” specialist. 

PRESIDENT: Of the Earth Alliance. 

PATTY & KAI: Control room workers. 
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Text on screen with voice over 

Graphics through the Universe on the way to planet Orius from Earth underlay the text. 
VO: The year is 2153. Earth’s population has expanded beyond its ability to support the volume of human live. Five years 

ago 228 people inhabited another planet as part of project “Genesis 2”. 

VO: Their new home, Orius, has been the only other planet found that can sustain life – a thin atmosphere, rich soil and 
water were present. This group was preparing the planet for more humans to join them – to build a new society. 

VO: Plans had been going according to plans and schedules…until now. 

Menu Option: Planet Orius 
Normally there are (2) different options. For sake a brevity, here is only one of the “paths”… 

Orius Exterior Commander Jones is working outside on a mechanical unit near a lake with trees behind him. 

JONES: Alpha station, the repairs to this oxygenation unit are nearly complete. Just in time, too – I’m. . . (listening to his 
headset – visibly agitated) Entered the system? Are you sure? We haven’t seen any indications of life. (listening) Are 
you certain the sensors are functioning properly? Weapons lock? Bring ground systems on line and begin transmitting 
the situation to EPOC command. Audio alarm begins in background

Orius Exterior. Different shot of Orius. Commander Jones is outside by a box near a water bank. We can see the missiles 
over a hill behind him. One streaks toward the sky. A warning alarm is sounding in the background. 

Zoom in / close up of Commander Jones as he looks up after the missile. He reacts to a mid-air explosion. 
JONES: What do you mean you can’t get a lock on this thing? Pull everyone inside, and see if the other probes have been 

engaged… 

Orius Exterior The water is pulled from the planet (CG). 

Orius Exteriror should look like the same location where Jones was working- no water, and the land is ravaged. Gold Mine 
zoom out. 

Opening Credits 

Conference Room. There are 2 high-ranking officials sitting around a table. 

Voice is heard over speakers – “The President is coming on-line now”. 

At the head of the table, the President is present via hologram. 

PRESIDENT: Can you give me a status update of the situation? 

DAVIS: The alien ship is approaching the Mercury defense ring. They will be within range of two of our perimeter un-
manned defense shield satellites. 

PRESIDENT: How will they engage the alien threat? 

DAVIS: First they will broadcast a declaration of inhabitance. 5 seconds after that has begun, if the aliens don’t respond, 
stop or slow their flight speed by 10%, both satellites will initiate target lock, and inform the ship that they have 3 sec-
onds to comply. At that time, they will send a warning shot 5 degrees off of the aggressors flight path. 

PRESIDENT: And what if they do not respond to our warnings? 

STRYKER: Each of the Mercury defense ring satellites is armed with 3 types of missiles, Mr. President. A T-531 which is 
basically a large flare for the warning shot, a P-12 conventional warhead which has a great deal of speed, and a Q-457 
nuclear device that could move even the moon off its trajectory. 

Voice-over “Declaration of Inhabitance has been activated on MDF-G3” 

DAVIS watches the display monitor to see the play. 
DAVIS: Green means status is “normal”. Yellow indicates system activation and broadcast initialization. Orange; “Warning 

Shot has fired”, and red means the nuke has been armed for launch. (At this moment, one satellite goes from yellow to 
flashing blue, and the other satellite goes from Green to Orange) 

PRESIDENT: And what does Blue indicate? 

DAVIS: Well, it’s not suppose to.. The flashing blue has stopped – that satellite is no longer listed. The other satellite has 
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changed from Orange to Red, but a blue ring has begun flashing around it. 
STRYKER: Interrupting Blue indicates a lock has been established… (both satellites stop flashing) on our bird. 

Stryker bangs his hand on the table. Davis looks down as if he, personally, was defeated. 
PRESIDENT: I need options gentlemen. And I need them quickly. 

STRYKER: We already have a team working on that, Madame President. 

We see Katrina jogging around a lake. Suddenly, there’s a flashing red that seems to fill the sky. 

VO: “Incoming message”. Looking over Katrinas shoulder, we see a heart rate read-out, speed count, distance run, and 
“Serine Lake” on the screen. “Incoming Message” is flashing. 

KATRINA: Hello? 

STRYKER: We need you, Captain. 

KATRINA: So, this is an official call? 

STRYKER: Of the utmost priority. Additionally we require 5 other pilots that can get up to speed in a TG-1 quickly. Any 
suggestions? 

KATRINA: Sounds serious. 

STRYKER: It is. 

KATRINA: Get me Sleigh, Minorah, Thorn, Kingly and Cohen. I can be there in 6 ticks. 

STRYKER: Very good. Stryker out. 

KATRINA: Jogging Off. 

Message turns off, and suddenly Katrina is standing in black. She mimes reaching to remove a helmet. 
Katrina is now in a gym on a conveyer. We see her removing a helmet which had been projecting the lake around her. 
VO: You ran 12 point 5 kilometers in 8 minutes and 12 seconds. Very good, Captain Billingsworth. 

Katrina hits a switch to turn the conveyer off, and walks away. 
Menu Option: Meet one of the best Starship Pilots on Earth 

Jasmine is playing with her daughter when her communicator beeps. 
MINORAH: Minorah here. 

STRYKER: Minorah, this is General Stryker. I understand you just started a weeks’ leave. I’m sorry, but you’re being 
recalled. 

MINORAH: Pauses for a moment, reflectively Where do you need me, sir? 

STRYKER: SitCom in one half hour. 

MINORAH: Yes, sir. Minorah out. 

Bedroom. Close-up on Thorn. She’s breathing heavily as if she has been running a great distance.
We hear a communicator beep off SL. 

RILEY (off camera): I thought you turned that off. 

LUCINDA: I have it set on Priority 3 – I know the drill. She reaches over to a nightstand, grabs a communicator and 
slips it on. She’s wrapped in a sheet or something. No nudity on camera – but bare shoulders & maybe a low back and 
incidental leg. 

LUCINDA: Thorn here. 

STRYKER: Lieutenant Thorn, we have a priority briefing for you in one half hour. Join us in the SitCom. 

LUCINDA: Yes, sir. Right away. . . I understand. 

Turns off communicator. 
You won’t believe this. Do you know who that… 
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Communicator beep off SR. 
RILEY: You’ve got to be kidding. 

Riley was sitting up on top of the bed. Lucinda is finishing putting on a robe in the background, getting ready to jump in a 
shower and get dressed. 

STRYKER Off-camera: Lieutenant Cohen, we have a priority briefing for you in one half hour. Join us in the SitCom. 

RILEY: Yes, sir. May I ask… 

STRYKER: This is top priority, Lieutenant. You will be informed upon arrival. Stryker out. 

RILEY: To Lucinda Looks like we’re both being brought in. 

Exterior Mountain, snow area. 
Jack is bundled for snow machining. 

He gets a call inside his helmet. 

JACK: Kingly here. This better be good. 

STRYKER: Corporal Kingly. 

JACK: General Stryker (He’s nervous for having been so relaxed. He sits up and is more formal). What may I do for you 
sir? 

STRYKER: We have a priority briefing for you in one half hour. Join us in the SitCom. 

JACK: A half hour could be a little rough, sir. I’ll need some assistance for that sir. 

STRYKER: (As we hear helicopter-ish sounds drawing near) Transportation has already been arranged, Corporal. (A 
shadow comes over Jack’s face as he looks up). 

Kyle is in the Pub playing pool with some friends. Dale, Mike & Tracy. Extras OK.
It’s midday, though, and they’re in a pub – so it shouldn’t be too busy. 

KYLE: OK Guys, watch and learn 

DALE: Nice Shot 

MIKE: Did you handle your balls that well last night? How’d it go with Julie? 

KYLE: I don’t know… I wasn’t the one handling the ‘stick’. 

TRACY: C’mon, quit being disgusting. Julie’s my friend. 

KYLE: We had a good time. That’s all. 

DALE: Can you still shoot straight after last night? 

MIKE: This man can never shoot straight. 

KYLE: Shut up guys 

<BEEPER> Kyle puts on his communicator. 
KYLE: Casually This is Sleigh, what’s the play? Realizing it’s official, he stands straighter. Oh, yes sir. 

GENERAL STRYKER is on the communicator. Shot from the perspective of looking through his communicator glass 
– Stryker is a pale blue projection over the pool hall background. Corporal Sleigh, we have a priority briefing for you in 
one half hour. Join us in the SitCom. (SITuation COMmand room) 

KYLE: Yes, sir. Right away….I understand. 

KYLE: Well, gotta go 

DALE: Just as you were about to start losing. 

KYLE: In your dreams, Dale-face. 

Kyle leaves via the door, gets on his pod, and races off. This will require a few location shots to get him racing off. 
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Briefing room. General Stryker is standing in front, projections are on him and the screen behind. 
Pilots are sitting in the room. 

STRYKER: Two weeks ago Orius was attacked. We don’t know who or what it was…but they are obviously not friendlies. 
This ship was picked up by our satellites and is now on its way to Earth. Two of our MDF, (Mercury Defense Field) 
satellites were engaged and destroyed. This ship shomehow pulled every drop of water off of Orius. No vegetation is 
left on that planet. The aliens are now six days from our orbit. 

KYLE: We don’t know what they are or where they’re from? 

STRYKER: Orius satellites reported that this ship came from an opposing sector of space that we haven’t even been able to 
view yet. That was port of what the Orius settlement was going to achieve once fully operational. 

LUCINDA: Why are there only six of us at this briefing, sir? Shouldn’t we be preparing a larger defensive? 

STRYKER: You are not a defensive team. We have prepared a plan for a small offensive attack. One that is of high risk, 
but we feel it also has a high probability of success. We are assuming that this ship is so massive in size for the purpose 
of storing stolen water. Thus, we are extremely concerned about the devastation to Earth if we destroy it inside our 
standard defense perimeter and gravitational pull. 

RILEY: How do we deal with the problem then, sir? 

STRYKER: We believe a level 3 nuclear missile has the capability to destroy their vessel, but it has evaded two we have 
ground-launched at it from satellites. We have been studying images of the ship and feel that the enemy has a blind spot 
behind its main tower. Also, because of it’s size, it moves relatively sluggishly. We believe that a small, agile craft, at 
close range, would be able to effectively arm and launch a missile to eliminate the target. 

KYLE: How the heck is a ship going to get close enough to leave a missile at their back door? Should we pretend to be the 
milkman? 

KATRINA: Sleigh! 

STRYKER: Enough! The target’s trajectory brings it very close to Saturn. We believe small crafts could mask themselves 
in the ring asteroid belts, swoop around the planet, and emerge alongside the alien ship before being detected. If your 
ships were to leave the belts simultaneously, the aliens would be surprised by the readings so close in proximity, and 
would delay their response with enough time so that the missiles could be launched. 

JASMINE: So the six of us are going to save the planet? 

STRYKER: Actually, only four of you will go. We have four ships, part of project Trans-go that are under development 
that we are confident can handle this payload and schedule. We are still determining who is best suited for this mission. 
Captain Billingsworth is the only pilot among you that has been trained in these prototype Trans-go’s, and will lead you 
through training over the next 30 hours. This is an extremely high-risk assignment, boys and girls. We feel the mission 
has a 92% probability of success. You have been selected due to your top skills as fighterpilots, and dedication to the 
core. You represent our best chance to eliminate the threat without world-wide panic. Good luck. 

Training 
JACKSON: There are 5 distinct phases to this mission. 3 of those are the most dangerous, and where your training will 

focus. 

Phase 1: Take-off. Most of you are fighter pilots. You may be the best, but you haven’t dealt with anything close to the 
G’s it takes for the TG-1 to break out of the Earths atmosphere. These ships have been developed to take advantage of 
aerodynamics and the thinning atmosphere differently than any ship before. These bad boys make use of solar energy to 
augment the use of our standard fuel – as the heat created by your ship increases by your skidding against the layers of 
atmosphere; the TG actually gets more powerful and faster. It’s a delicate balance, however. And the ride is a rough one. 
If you deviate from optimal incline too far – you won’t make it. So, you need to get some time in on the vomit comet; get 
your body and mind use to the type of forces you’ll be facing up there. Keep you head, stay in control, and these birds 
will give you the ride of your life. 

Phase 2 is flying to Saturn. This should be relatively simple; you just need to stay on course. Once you’re free from the 
Earth’s atmosphere, that solar energy collection panels will kick into high gear, and you’ll be traveling faster than anyone 
ever knew is possible. 

Phase 3 is maneuvering through the ring of space debris that has formed around Saturn. These ships are tough, but they 
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weren’t designed to take this kind of physical impact. A few “bounces” and they’ll hold up fine – but if you come into 
direct contact. . . well; your going to be in trouble. 

JACKSON: Phase 4 is pulling out of the ring, and after the primary target. You want to come out as close as possible to the 
alien ship, and in a tight formation. We believe our – and the alien – sensors will be blind to your ships in the belt. Too 
many objects, materials and alloys should confuse everything. But, since you’ll be in it – you should be able to detect 
their ship because it will be the only thing changing outside of the ring. Breaks in the density of the field will allow you 
to get a very close proximity gauge on exactly where the enemy is located. 

Phase 5, you get behind them as quickly as possible and deliver your payload. As the General has pointed out, the enemy 
has a “blind spot” behind their main tower. Although it may not seem righteous attacking this enemy from behind; that’s 
all these water-suckers deserve. Remember; we’ve tried to make peaceful contact with them to no avail. This is a destiny 
they have chosen to deserve. 

Vomit Comet: 

DIRECTORS NOTE: I’m hoping these will be able to translate well without words. I’d like this to be 
somewhat comedic (though not outrageous slapstick). 

Each pilot takes a turn in this chair – which is supposed to be spinning at incredible speed. Before 
each one goes, Jack hands them a (vomit) bag as a joke. 
When Jasmine gets off she’s stumbling slightly. Kat and Jack help her to her feet. Jack walks off with 
her; Kat stays to work with the others. Jas hands him the bag, which he passes on to Riley. 
When Riley gets off, he’s slightly wobbly – but can walk fine by himself. He gives the bag to Lucinda, who he wises “good 
luck” to. 
Lucinda gets off, and is trying to hide the fact that her stomach is, indeed, woozy. She gives the bag to Jack (trying to be 
smug about it) and when he steps into the chamber, she quickly dashes to a trash can and throws up into it. Riley, Kat and 
Kyle are trying not to laugh. Riley knows if he does; he’s in trouble. 
In the chair, Jack has no visible signs of trouble. When he gets off he’s walking tall with attitude. 
He passes the bag to Kyle who snickers with confidence. When Kyle gets off, he’s wobbly and throws the bag in the trash 
can – it lands with a “thud” and he wipes his mouth with his sleeve. He’s noticeably “green”. 
Kat looks at the trash can, and at Kyle, then she goes into the chamber. She too looks fine in the chair – and gets off walk-
ing tall. 

“Asteroid Avoidance” 
KATRINA: Watch your 3o’clock! 
JASMINE: Taking a small “hit” <Blue Flash> Frak! 
KATRINA: It’s OK. Just keep bobbing in and out. 
JASMINE: Whew – this is a long time. 
KATRINA: You’re almost through. Just a little longer. 
JASMINE: How do you - <beep> I’ve got them on radar! 
KATRINA: Good! Now pull out. Good job! 
JASMINE: Lightly – with good cheer, respectful ease; Thanks, boss. 
STRYKER: Over the loudspeaker: Let’s get Cohen in there. 
KATRINA: You all set? 
RILEY: Let’s do it! 
KATRINA: OK, let’s bear left and enter the debris. 
RILEY He’s extremely focused. When Kat gives him advice, he’s slightly annoyed – and remains intently silent the entire 
session. 
KATRINA: Good… now keep your nose down. 
KATRINA: You better… he pulls a hard right to avoid two asteroids, making her “note” useless – (slightly under her 
breath) good. 
<beep> 
KATRINA: You’re out of there! 
Walking away, Riley basically ignores Kat, and passing Lucinda, he gives her a wink – knowing he did well, and feeling 
proud of himself. 
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STRYKER: Over the PA: Here we go! 
KATRINA: The ring is to your left… not so steep! 
Lucinda hits an asteroid as she enters the ring. 
Control Booth: Stryker looks at a blue light flash. “Contact”. 
Lucinda is visibly having trouble. 
KATRINA: Watch which way their spinning; it can help you decide. . . 
Lucinda hits another rock. 
Control Booth: Stryker looks at a red light flash. “Catastrophic”. 
LUCINDA: Under her breath; Get out of my head. 

KATRINA: Keep your nose down – 
Control Booth: Stryker looks at a blue light flash. “Contact”. 
LUCINDA: Still flying, she closes her eyes for a second, and is re-focused afterward. She no longer has a hard time…. 
<beep> 
LUCINDA: And there we go! 
- - - - - - - - 
Jack gets into the chair and Stryker comes over the loudspeaker; (Jack and Kat look up to listen) 
STRYKER: Let’s take 5, guys. I have to take a call. 
JACK: Finally some time alone together. 
KATRINA: I wouldn’t exactly say we’re alone. 
JACK: You know what I mean. You always do. Or, you use to. 
KATRINA: Yeah, well, that was a long time ago. So, how have you been Kingly? 
JACK: “Kingly” now? I guess it has been a long time. I’ve been doing well. 
KATRINA: How’s the knee? 
JACK: Almost perfect! It won’t effect my flying. 
KATRINA: That’s not why I’m asking. (She truly cares here for a minute) 
JACK: Well, everything changes. I heard you’re the one who called me into this. 
KATRINA: We needed the best pilots. 
Jack: Holding himself up, ready to crack a big joke and flash some ego – she cuts him off; 
KATRINA: HEY! (Seriously, but not “heavy” – just straight talk;) You are the most naturally gifted flyer I’ve ever met. 
JACK: Still? 
KATRINA: Still. Not everything changes. 
They share a look with each other. They are truly friends at this moment. What they share here is the fact that they are the 

two best pilots, and leaders, for this group. 
KATRINA: Let’s get you set up now. You haven’t flown this puppy – it’s a trip! 
Training booth: 
STRYKER: He’s doing well. 
JACKSON: To an off-screen worker; Let’s turn it up a notch! 
KATRINA: That’s good, but careful! These TG’s love to spin. 
JACK: Heck, so do I! I’ll just dance from one rock to the other! 
KYLE: Finishing getting “strapped in”: OK, so I enter it on my left? 
KATRINA: Correct. 
KYLE: OK. Let’s do this thing! 
KATRINA: Here it comes… 
KYLE: Almost to himself On the left… 

KATRINA: Ease it in – good! 
KYLE: At first he looks almost overwhelmed. A lot of “darting” back and forth. 
KATRINA: Ease off a little. Work your way into the flow – 
KYLE: Rolls his lip, turns a little to the right, then finds a “smooth” patch. He smiles slightly and looks more at ease. 
KATRINA: Good. Keep your nose down – 
<beep> 

Control Room: 
STRYKER: Let’s turn up the heat on this one, Major. 
We see a hand pushing up a few levers. 
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Jack is “on deck” watching Kat “perform” 
STRYKER: Over the PA: OK, here we go! 
KATRINA: Whoa! There’s a quick flash of surprise as she nearly gets clipped by a rock – then realizes it’s a lot denser of a 

field than everyone else had. She almost smiles as she realizes the General is “playing” with her a bit. 
She nods slightly, and becomes quite focused. She’s dodging at quick speeds. 
Jack smiles as he sees her “whipping ass”. 
<beep> 
STRYKER Over the PA: Good job. 
JACK: Impressive. 
KATRINA: Playing with Jack – Well, as I said before; not everything changes! 

Menu: Choose the commander of the mission. 
Menu: Choose the other 3 members of the flight crew. 

For the sake of brevity for your reading just one of the options (out of 60 possible strings!) I’m only including one 
scenario here. 

Please understand, however, that the ability for the audience to choose the destiny of the mission (and Earth itself) is a 
major concept for this type of “interactive entertainment”. 

Briefing Room
STRYKER: I have called you all here together because, as you know, we unfortunately only have four TG-1’s for this most 

important of missions. (Cross fade to watching the pilots anxiously awaiting the announcement of the team leader) All 
of you have performed well during training. We all appreciate the hard work, time and dedication you have all put into 
this project. These decisions were difficult to make… 

The mission leader will be Captain Billingsworth 

“Water Stealers DVD” an interactive DVD by Kade Mendelowitz Page 10 of 15, 2/11/2004 

The 3 wing pilots will include: 

Lieutenant Cohen 

Corporal Sleigh 

And the final member of the team will be Corporal Kingly 

STRYKER: Mission “Rainstorm” will go at eleven-hundred hours. Until then, you’ve all earned a night off. Dismissed. 

They all go to congratulate the leader (taking turns at who that is) 
JACK: We’re all meeting at the “Launch Pad” for a drink! 

KATRINA: Yeah, we all need a “Blue Ball” tonight. 

JACK: First round’s on the Captain! 

KATRINA: Excuse me? 

JASMINE: You owe us for working us so hard. 

EVERYONE: Yeah! 

Lucinda and Riley are out at a campfire. 
RILEY: Are you sure this is what you want to be doing on what might be our last night together? 

LUCINDA: It calms me to be doing something normal. 

RILEY: Normal? When’s the last time you had a campfire? I don’t think we’ve ever done this. 

LUCINDA: When I was a little girl my father and I would go into the backyard with a telescope and make a campfire. 
We’d read the stars and then sit around making up stories about all of the worlds and stars out there. 

RILEY: Were any of them filled with creatures that stole water? 

LUCINDA: I’m not joking here Riley. 
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RILEY: Well, if “normal” calms you, joking calms me. The whole situation seems a little surreal. 

I can’t believe we’re not going up there together. I can’t stand the thought of leaving Earth without you tomorrow. 

LUCINDA: As if she didn’t hear his last statement because she’s too lost in her own thought I’m not sure when I stopped 
looking at the stars with such a sense of wonder. I guess when I became an astrologist and pilot the science took over, 
and my imagination stopped filling in the blank spaces. 

RILEY: I love you, Luce. With you, I feel my life doesn’t have blank spaces. 

They kiss. 
Kyle is playing another game of pool. 

MIKE: Hey, man! We haven’t seen you for days. What’s up? 

DALE: Afraid to show your face after you had to run away last time? 

KYLE: No, just too busy for the likes of you. 

TRACIE: What have you been doing? 

KYLE: I could tell you, but then I’d have to kill you. 

DALE: Mike, why don’t you get the man a blueball while I rack up again to kick some officer butt. 

TRACIE: Kyle, I spoke with Sarah earlier. Are you planning on calling her again? 

KYLE: I wish I could right now, but I’m not sure the timing is right. 

TRACIE: What is that supposed to mean? Why don’t you call her right now? 

KYLE: Because tonight I’d like to hang out with you guys – my friends. Is that OK with you? 

TRACIE: Well, sure, but I’d hoped she’d be your friend too. 

“Water Stealers DVD” an interactive DVD by Kade Mendelowitz Page 11 of 15, 2/11/2004 

KYLE: Look, I just don’t know if I have time in my life to handle anything else, OK? There’s a lot goin’ down on base. 

MIKE: Whoa, man. What’s your malfunction? She’s just askin’ what’s happening with you. She cares. 

KYLE: Well maybe caring isn’t always enough. 

MIKE: What on earth are you talking about? You’re freakin’ out. 

KYLE: Angry Hey, I just wanted a good time tonight. Apparently that’s too much to ask for. Tonight, of all nights, I don’t 
need this. Look, Trace. I’m sorry you don’t think I’m living up to my end of the deal. But I am –I’m living up to it in a 
major way. I’m payin’ my way. In fact, I’m payin’ yours too. I don’t know if I’ll ever see Sarah again – so I don’t know 
if I want to get to know another face I have to be responsible for. You don’t know what it’s all about. He leaves bumping 
into Lucinda and Riley on the way. . . 

Mike and Tracie look at each other astonished. Dale is unfazed and unaware. 
Lucinda and Riley are coming into the Bar. Everyone else is already there, though Kyle’s on his way out. 

LUCINDA: Hey, Kyle. 

Kyle passes her without really noticing her. 
RILEY: Yo’, Kyle. What’s up? 

KYLE: I’m out of here, man. I can’t take it. 

RILEY: Yeah, it’s rough. 

Lucinda’s been standing by a table where Jack and Jasmine have been sitting. 
Riley walks over 
LUCINDA: Well, we’ve all got our own head trips to deal with. 

JASMINE: So, where have you two been all evening? 

RILEY: Someone wanted to do something “normal”. 

JASMINE: What’s not normal about drinking before a mission? 
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JACK: Why don’t you get your fine lady a drink and sit down? 

JASMINE: Oh, I’ll go get it. It’s my get. 

JACK: In that case, wench, get me a tall one! 

JASMINE: Slaps him in the back of the head, playfully. Well, it’d be nice if there was something tall about you. 

JACK: Hey, that’s low girl. 

LUCINDA: Sitting down. Well, she did have to “stoop” to your level. 

RILEY: Sitting down Oh, you’re “puny” 

JACK: Oh, you wound me! Faking being stabbed in the heart 
Katrina’s sitting at the bar, drinking. Jasmine comes over to order – signaling 4 fingers. 

JASMINE: Hey, Kat. How’s it going? 

KATRINA: Well, I’m not sure, actually. 

JASMINE: You’re not? 

KATRINA: Put it this way; I’m not sure how I’m suppose to feel. 

JASMINE: What do you mean “how” you’re suppose to feel? 

KATRINA: Someone proposed to me today. 

JASMINE: Why that’s great! 

KATRINA: It is great, I mean, he’s great. I’m really happy about that. It’s just that I’m suppose to go up tomorrow. 

JASMINE: Is the amazing Captain Billingsworth having doubts? 

KATRINA: That’s just it – I don’t have any doubts. I know he’s the right man for me, but I know I have to go on this 
mission in spite of it. 

JASMINE: That’s good. Drinks are put down in front of them. You can’t let a man get in your way. 

KATRINA: Would it be so easy for you? 

JASMINE: Hey, no one said it would be easy. But I would be honored to be going up there. And I’d be extra motivated. 
Not just for the faceless billions of people you’re going to protect – but for my David, and my Rachael. 

KATRINA: Interesting perspective. 

JASMINE: Yeah. Real interesting. Look, you have to do me a favor. You have to make sure that ship never gets to Earth. 
You have to help me see my little girl grow up to become a pilot just like her momma. You have to kill those bastards 
for what they did to the people at the Orius settlement. 

KATRINA: I hear what you’re saying… 

JASMINE: And you have to do one more thing, too. 

KATRINA: What’s that? 

JASMINE: You have to get off your butt and join us for a drink! 

The five pilots are together: 
JACK: Hey, there’s the woman of tonight! 

JASMINE: Let’s have a toast! 

JACK: To Captain Kat! 

They raise their glasses together and take a drink. 
Control Room. Patty, Blair and Stryker are there. Patty and Kai are at computer stations. 

PATTY: Systems are green “Rainstorm” leader. You are cleared for take-off. 

KATRINA Roger that, mission control. The “Rainstorm” is taking to the sky. 

Ships take off from Eielson 
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KATRINA* Storm front is in the air. 

RILEY Storm cloud is in the air. 

JACK Storm strike is in the air. 

KYLE Wind Storm is in the air. 

KATRINA Sleigh, your tails wagging. 

KYLE Visibly having trouble Yes sir, my lifting thrusters are having a hard go of it. 

PATTY Wind Storm, check your gauges. 

KYLE Beeping He’s looking around 
KATRINA Sleigh; report. 

KYLE It’s getting warm in here. 

STRYKER Abort the mission, Corporal. 

KYLE No, sir. I think I can handle it. 

MARGARET It’s no good – you’re running too hot. 

KYLE I’m almost free. . . 

Kyle’s ship explodes 
KATRINA Tower, this is team leader. We are one down. The remaining Storm fronts have cleared the atmosphere and are 

on target trajectory. 

STRYKER: What’s the ETA before they arrive at the asteroid ring? 

PATTY: Six hours and thirteen minutes, sir. 

General leaves the room. 
We see him walking down a hallway. 
Patty and Kai look at each other. 

General’s Office- dark. Camera is behind the desk. 
General walks in and sits at his desk. There is a photograph on his desk of MAGGIE 
*Flash-back to the Gazebo 

STRYKER: I wish I didn’t have to send you on this mission. 

KATRINA: But if I weren’t such a hot flyer you wouldn’t love me half as much as you do. 

STRYKER: Perhaps. Or maybe it’s just because you’re hot – period. 

KATRINA: Aren’t you the charmer today? 

STRYKER: I just don’t want anything to happen to you. This is a very high-risk mission. 

KATRINA: And that’s why it’s important to send your best. And if I wasn’t your best, you’d be in a lot of trouble. 

STRYKER: Marry me. 

KATRINA: What? 

STRYKER: I want you to marry me. Hell, I’m not any good at this. 

He gets down on one knee Would you, Miss Katrina Billingsworth, do me the honor of joining me in holy matrimony? 

KATRINA: Is this for real? 

STRYKER: As soon as you set foot back on planet. 

He fumbles for a ring. 
KATRINA: You are the sweetest man. . . of course I’ll marry you! 

They kiss. 
Phone rings . . . cross fade to office 
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STRYKER: Stryker here. 

BLAIR Voice Over: They’re approaching the debris belts, sir. 

Stryker gets up and starts heading out. 
KATRINA OK you two. Let’s look alive and stay alive. 

RILEY Keep your eyes on the prize. 

JACK Let’s fly this ring and do our thing! 

Control Tower: 
PATTY: They have entered the belt, and we’re losing radar. 

KAI: That’s expected, sir. 

STRYKER: Yes, let’s just hope that the aliens’ sensors are not more effective than our own. 

PATTY: The aliens have come into range. Bearing 240 mark 6 degrees. Just as projected. 

KAI: Jesus, Patty. 

STRYKER: Lieutenant? 

KAI: The alien ship sir. It’s huge. It’s almost as large as two battle cruisers. 

KATRINA We’re coming around – almost there! 

KATRINA Prepare to leave the belt. Stay at least 2 lengths behind me – we don’t want to be too close when they spot us. 

RILEY Radar is clearing up. 

JACK Almost in position. 

KATRINA We’re on mark. Now, move out! 

JACK We have cleared the asteroid belt and are gaining on the bogie. 

RILEY Radar is showing them 32 grids ahead. 

KATRINA Engage at full throttle. We need to be nearby to verify target lock. 

JACK Sir, I think I see something coming out of the bottom of their ship. 

KATRINA There are two smaller crafts being deployed. You two break off in “Evasive Gamma” and see if you can draw 
them away. I’m going on to the mother ship. 

RILEY, JACK Initializing Gamma sequence. 

KATRINA They’re both heading after Cohen – Kinlgy, pull around and engage the target. Cohen; watch your six! 

JACK I’m comin’ Riley. . . Hold on! 

RILEY These guys are coming in fast . . . I can’t shake them. 

KATRINA Cohen, try to bring them in towards Kingly. Jack step on it! 

JACK Waves head around, trying to follow a ship, then...excited 
I’m locked on! Fire in the sky! 

RILEY They’ve got a lock on me! 

One of the alien fighters blows up. 
KATRINA Kingly, can you get their second? 

JACK Almost there. . . 

RILEY Can’t shake ‘im… 

JACK Got a lock! 

Alien fires 
JACK Fire in the sky! 
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Riley is destroyed. Jack is horrified. The second alien fighter explodes. 
KATRINA I’m in range. Missile 1 is armed and active. 

JACK We’ve lost Cohen. 

KATRINA A fast sadness washer his/her face, but he/she must complete the mission, and make sure the other pilot doesn’t 
lose their cool. Pull up here into position and let’s knock these guys out of our space. 

JACK Didn’t you hear me? We’ve lost Cohen! 

KATRINA Let’s make sure it’s not in vain. Get your stick in gear. 

JACK They’re pulling around. 

KATRINA I can’t get a lock! 

JACK They’re tracking you! 

KATRINA My sensors aren’t able to get a solid fix on them! They must have some way of scrambling our works. 

JACK They’re gearing up! 

KATRINA I’m trying a manually targeted launch. Come around to their heading! 

JACK They’ve got a clear shot – you’d better hurry! 

KATRINA Missile one’s a launch. Fire in the sky! 

JACK They can track us for sure! Darn! You missed the target! What are we going to do now? 

KATRINA I still can’t get a lock on these freaks. We can’t let them get much closer to our atmosphere. 

JACK They’re re-adjusting towards earth. 

KATRINA OK, hot shot. I need you to buzz across their tower. Get all of their attention to the opposite side of their ship. 

JACK And how close do you expect me to get to them? 

KATRINA I don’t know if those bastards have hair, but I want you to give them a shave they won’t forget. 

JACK Smiling. This is the kind of challenge you strive on. One buzz-by coming up. 

KATRINA On my mark (Arms missile two) mark! 

JACK Thrown back in seat I’m goin’ in hard, I’m goin in strong! 

KATRINA There is a coldness in eyes, voice is monotone. Looking good. Just a few more seconds. 

JACK I’m almost at their tower. . . 

KATRINA Pull to the right and run for cover! 

JACK Pulls hard to the right. Checks sensors. They’re swinging around to follow! 

KATRINA Just keep heading out, get a lot of distance! 

JACK What are you doing, KATRINA? 

KATRINA Tell the General I Love Him. 

JACK What? A look of horror comes across your face 
Then KATRINA comes up from below and rams into the alien ship. The large ship explodes. 

Control Booth 
PATTY: Excited Target has been destroyed! 

KAI: Three kills confirmed! Three casualties, as well sir. Couldn’t be avoided. 

Text on screen with voice over 
There are some who will say that we shouldn’t go where we don’t belong. That humans have no right to colonize other 

planets. Some will say that these times are inevitable; that whatever other life is out there must be met and dealt with. 
There are others who feel that we must limit our population before it destroys us all. That this planet is our home, and 
our mother, and that we, as its children, must learn to live within its boundaries. That we must not exploit her resources, 
take her for granted or ignore her beauty. And a few will mourn the loss of lives that were lost too soon.
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Assignment 7
Radio Commercial

Make a :30 second radio commercial for “Water Stealers”.

You may come up with your own wording, though you must include:

    * “Water Stealers”
    * by Kade Mendelowitz
    * www.waterstealers.com
    * $15
One possible script:

In the year 2153, and the Water Stealers are on their way to Earth!  Join the adventure as you 
take control of the mission with this interactive DVD by Kade Mendelowitz.  Visit www dot water 
stealers dot com to learn more about this unique form of entertainment.  Play on line or buy your own 
for $15.  The water stealers are coming - are you ready?

Music: You may use whatever music you wish.

I recommend you:
1.	Read the script (see below for download information for the script) & visit the website to get a 

feel for the piece. 
2.	 Come up with a concept and Write the script 
3.	 Set a meeting time and Record your “talent” (that’s what the person supplying the voice is called) 
4.	Mix the final version. I would think this could be done well in a two-step / time-slot process. 

This is a project to have fun with.  Impress me! Wow your friends! 

Assignment 8
Go through “Equipment” “Microphones” on the DVD and answer:

These microphones are most often used for handheld live sound reinforcement because they are 
generally the most durable:	 ___ Dynamic	 ___ Condenser	 ___ Ribbon

These microphones require “phantom power” (either battery pack or supplied from the mixing 
console) to operate:	 	 ___ Dynamic	 ___ Condenser	 ___ Ribbon

The microphones are very fragile (and expensive) so they’re most often used only in studio 
settings:	 	 	 ___ Dynamic	 ___ Condenser	 ___ Ribbon

An omni-directional microphone pickup pattern refers to:

Cardiod pickup patterns help avoid feedback because:

What are three major disadvantages to using even high-quality wireless microphones in the Theatre:

Often theatres line the front of their stage with Phase Coherent Cardiod (PCC) microphones 
because they are good for:
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Assignment 9
Watch the two video lectures “Creation & Procurement” and “Implementation” on the DVD.

Assignment: Make a “radio” show (all audio) version of this scene: 

A Living Room in a Virginia suburban home. 

John is sitting on the sofa. Lori, his wife, enters the room. 
Lori 	Are you just going to sit there all day?

 Lori doesn’t wait for an answer as she goes through the room and through the archway 
upstage right. 

John Hmm. 

 about a minute passes, and she walks back through the room. 
Lori 	Why don’t you go and (looks up at ceiling) I wonder what the boys are up to.

John I don’t know. Annoying, though. 

Lori 	Well, you should just sit there and let them break something else, huh? As she goes back into 
the kitchen

John Great. Waits a minute yells What are you two doing up there?

Billy 	Offstage Nothing! Just playing! 

Assignment 10
Water Stealers - Video Sound track 

Because it can be a huge challenge to get live actors to rehearse and adjust their schedule(s) for 
us to use as an example play for creating audio cues; I have created some video clips for you 
to use instead.  By now you should have read the script, developed an idea - or concept for the 
audio, and even created a commercial for the project...now it’s time for the hard work and fun!  On 
the DVD, in the “Resources” “Videos” folder, there are three files: two scenes from “Water 
Stealers” (with dialogue, but without effects) and a Audio Demo / introduction to using Adobe 
Premiere for editing audio for video.

Unfortunately, I do not know of any high quality audio editors which are free that can handle video 
clips and multiple audio tracks; so I would recommend downloading a free, 30-day trial of Adobe 
Premiere - and be sure to edit both of your clips within this time frame.

The “Pool A” scene is on Earth, and more normal than the Orius clip, so I would recommend view-
ing the audio demo I’ve made (which uses the Pool scene as an example) then try it yourself!  I 
recommend not working on both clips at the same time; give yourself a break between projects, 
as you will learn a lot from doing the first project and giving it some time to “sink in”.

Assignment 10: Take the video clip from Water Stealers (“Pool” scene) and add a full sound track 
to it. 

Make it fun, make it intricate. Have fun! Impress your friends! 
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Assignment 11
Go through the rest of the “Equipment” sections of the DVD.

Assignment 12
Assignment 12: Take the video clip from Water Stealers (“Orius Exterior” scene) and add a full 

sound track to it. 

Make it fun, make it intricate. Have fun! Impress your friends! 

Assignment 13

Go to the store 
Via sound, make a trip to the store to get some items (it doesn’t have to be bread) 

Length: between 2:30 (2 minutes, 30 seconds) and 5:00 (5 minutes). 

You are allowed dialogue, but not narration.

Assignment 14
Sound Final is SCARY! 

The assignment: Universal Studios (competitor of Disneyland) is developing a new “Attraction” - a 
haunted ride. You have been hired to come up with a sound track for the attraction - visuals (in 
this fictional situation) would be based around your audio track. You have complete freedom; it can 
be a walk-through, a boat ride, roller coaster, whatever you develop. 

No shorter than 3:00 minutes, no longer than 5. 

At this Final time, you should create a final compilation CD with your files on it - all of your assign-
ments other than the “Water Stealers” sound tracks. 
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